®

Minitab 18

Installation Guide

Minitab®, Quality. Analysis. Results.® and the Minitab logo are registered trademarks of Minitab, Inc., in the United
States and other countries. Additional trademarks of Minitab, Inc. can be found at www.minitab.com. All other marks
referenced remain the property of their respective owners.
©

2017 Minitab Inc. All rights reserved.

2

Contents
Basic Installation ............................................................................................................................................................4
Step 1: Designate authorized users of multi-user licensing web pages ................................................................................... 4
Step 2: Determine installation configuration........................................................................................................................................ 4
Step 3: Create license file(s).........................................................................................................................................................................5
Step 4: Obtain software.................................................................................................................................................................................5
Step 5: Install software...................................................................................................................................................................................6
Installation Configurations............................................................................................................................................7
Multi-user installation....................................................................................................................................................................................7
Configuration options...................................................................................................................................................................................7
Minitab License Manager.............................................................................................................................................................................8
License Files.....................................................................................................................................................................9
Using license files............................................................................................................................................................................................9
Adding a second product or additional users to your license file............................................................................................. 10
Renewing licenses.........................................................................................................................................................................................12
Advanced Topics...........................................................................................................................................................13
Installation options.......................................................................................................................................................................................13
Checking for updates..................................................................................................................................................................................13
Changing license types...............................................................................................................................................................................14
License manager utility...............................................................................................................................................................................14
Specifying ports.............................................................................................................................................................................................14
Options file......................................................................................................................................................................................................16
Command line installation........................................................................................................................................................................17
Identical settings on multiple computers............................................................................................................................................20
Troubleshooting...........................................................................................................................................................22
Index..............................................................................................................................................................................27

3

Basic Installation
This section provides the basic steps in a typical installation of Minitab 18. For instructions on advanced installation
options, see Installation options on page 13.
To install Minitab 18, follow the steps below. To renew an existing installation that has reached or is close to reaching
its expiration date, see Renewing licenses on page 12.
1. Designate authorized users of multi-user licensing web pages (optional).
2. Determine installation configuration.
3. Create license files at the multi-user licensing web pages.
4. Obtain software.
5. Install software.

Step 1: Designate authorized users of multi-user
licensing web pages
To access the Minitab multi-user licensing web pages so that you can create the license files for the installation, you
must be either the Minitab License Coordinator for your organization or an authorized user.
At the time of purchase, someone from your company was designated as the Minitab License Coordinator. That person
has permission to log in to the Minitab multi-user licensing web pages to create license files. In addition, your company
can have other authorized users.
If you are not sure whether you're an authorized user, contact your organization's Minitab License Coordinator. Only
the License Coordinator can request additional authorized users by contacting a Minitab sales representative or Minitab
Technical Support.

Step 2: Determine installation configuration
All multi-user installations require Minitab License Manager, the software that manages Minitab 18 based on the
information in the license file. Minitab License Manager must be installed in a configuration that allows it to communicate
with Minitab 18.
You can choose from several different installation configurations to suit your needs. For example, you can install Minitab
License Manager on a server in a networked configuration. In a networked configuration, users access the license file
on the server; therefore, each client computer does not need to be permanently assigned to a separate license file.
Another option is to install Minitab License Manager and Minitab 18 on each client computer in a standalone
configuration, which requires a separate license file for each client computer.
The installation configuration you choose affects the number of license files you need to create and the installation
procedures that you need to follow. See Installation Configurations on page 7 for detailed information that will help
you to determine the best configuration for your organization.
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Step 3: Create license file(s)
You need at least one license file for installation. To create license files, you use the Minitab multi-user licensing web
pages. One license file per server is required in a networked installation. One license file per workstation is required in
a standalone configuration. See Installation Configurations on page 7 for more information on networked and
standalone configurations.
You need the following information to create a license file:

•

The maximum number of simultaneous users that will be served by the license. In a standalone configuration, the
maximum number of users is 1 for each license.
To determine the maximum number of users in a networked configuration, see Number of license files on page
10.

•

The MAC address of each computer that will host a license. This is the computer's physical address. To obtain the
address, run the DOS command "ipconfig /all" and record the physical address that appears under Ethernet
adapter Local Area Connection. In the example below, the MAC address of the computer is 01-23-45-AB-CD-EF.
Ethernet adapter Local Area Connection:
Connection-specific DNS Suffix.:domain.local
Description....................:Broadom NetXtreme 57XX Gigabit Controller
Physical Address...............01-23-45-AB-CD-EF
Dhcp Enabled...................:Yes
Autoconfiguration Enabled......:Yes
IP Address.....................:192.168.1.1
Subnet Mask....................:255.255.255.0
Default Gateway................:192.168.2.100
DHCP Server....................:192.168.2.100
DNS Server.....................:192.168.10.200
Lease Obtained.................:Saturday, July 25, 2016 4:07:19 PM
Lease Expires..................:Wednesday, July 29, 2016 4:07:19 PM

For more information on how to obtain a computer's MAC address, see
http://support.minitab.com/installation/frequently-asked-questions/license-fulfillment/locate-my-computers-mac-address/.

To create license files
1. Go to http://it.minitab.com/support/licensing/multi-user/customer-entitlement-summary.aspx.
2. Log in as an authorized user.
3. Complete the necessary steps to create the license file(s).

Step 4: Obtain software
All multi-user configurations require both Minitab License Manager and Minitab 18. Download the applications from
the Minitab Web site using any Minitab.com account.

To download software
1. Go to http://www.minitab.com/downloads/.
2. Download Minitab License Manager and Minitab 18. The license file is read by Minitab License Manager, the server
software that manages the use of Minitab 18 based on the information in the license file.
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3. If you plan to mass deploy utilizing a software asset management tool, download the Minitab 18 Mass Deployment
Package.

Step 5: Install software
Install Minitab 18 and Minitab License Manager based on the installation configuration that you determined in step
2. You can install Minitab License Manager on a server in a networked configuration or on each client computer in a
standalone configuration.

System requirements
You can find the latest system requirements for Minitab and the Minitab License Manager at
http://www.minitab.com/products/minitab/system-requirements/.

To install in a networked configuration
1. Ensure that you have administrative privileges to install Minitab License Manager on the server and Minitab 18 on
each workstation.
2. Ensure that the license file is on the desktop of the server. See Create License File(s) on page 5 for more information.
3. Install Minitab License Manager on the server.
4. Delete the license file that is on the desktop. The installation program creates a copy of the license file in C:\Program
Files (x86)\Minitab\License Manager. The Minitab License Manager uses this license file.
5. Install Minitab 18 on each workstation.

•
•

You need to specify the name of your Minitab License Manager server during installation.
Minitab 18 chooses the first available port between 27000 and 27009. If your License Coordinator specified a
different port within the license file, check Specify port number, and enter that port number.

Note After you set up a networked configuration, you can use borrowing to allow a portable workstation, such as a laptop, to run Minitab
products while it is disconnected from the network. See Using Minitab products while disconnected from the network on page 7 for more
information.

To install in a standalone configuration
1. Ensure that you have administrative privileges to install Minitab License Manager and Minitab 18 on each workstation.
2. Ensure that the license file is on the desktop of the workstation. See Create License File(s) on page 5 for more
information.
3. Install Minitab License Manager on each workstation.
4. Delete the license file that is on the desktop. The installation program creates a copy of the license file in C:\Program
Files (x86)\Minitab\License Manager. The Minitab License Manager uses this license file.
5. Install Minitab 18 on each workstation.

•
•

When prompted for the name of the Minitab License Manager server, enter localhost.
Minitab 18 chooses the first available port between 27000 and 27009.
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Installation Configurations
The previous section explained how to install the multi-user version of Minitab products. This section provides a more
in-depth explanation of the client-server model and the possible installation configurations.

Multi-user installation
The multi-user versions of Minitab products are based on a client-server installation model. Minitab 18 (the client
software) is installed on individual workstations. Minitab License Manager (the server software) is installed on a server.
Every time the client software is started, it communicates with the server to ensure that a license is available.
Typically, Minitab License Manager is installed on a single server. The client software can be installed on an unlimited
number of workstations. Minitab License Manager ensures that the number of concurrent users never exceeds the
licensed number of seats.
For example, an organization purchased 100 licenses of Minitab 18 and configured Minitab License Manager to control
all 100 licenses. Minitab 18 was installed on 300 workstations. Even though the client software has been installed on
300 workstations, Minitab License Manager will allow only 100 instances of the client software to run concurrently.
When the client software is started, it requests a license from Minitab License Manager. If a license is available, it is
sent to the client and the software starts successfully. If a license is not available, an error message is displayed.

Configuration options
Networked configuration
To set up a networked configuration, install Minitab License Manager on a server. A license file is requested during
the installation process. You need to provide the license file that was created during the procedure detailed in Basic
Installation on page 4 (license files should always be named "minitab.lic"). Minitab License Manager is installed to
C:\Program Files (x86)\Minitab\License Manager (by default). The installation program makes a copy of the license file
and places it in the installation directory.
The Minitab License Manager installation creates a Windows service called Minitab License Manager. The license
manager service starts automatically when it is installed. When the service starts, it checks the Minitab License Manager
installation directory for the license file. If the license file is valid, the service starts successfully.
Install the client software, Minitab 18, on as many workstations as necessary. During installation, you need to provide
the name of the server on which Minitab License Manager is installed.

Using Minitab products while disconnected from the network
In a multi-user installation of Minitab, the client software must be able to communicate with the Minitab License
Manager server to start. To allow a portable workstation, such as a laptop, to run Minitab products when it is
disconnected from the network, Minitab has a utility built into the application that allows you to borrow a license.
For example, you might use Minitab on a laptop when you travel for business. Before leaving, while still connected to
your company's network, borrow a license from the Minitab License Manager server. Then you can access Minitab on
the laptop when you are disconnected from the network.
To borrow a license:
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1. In Minitab, choose Help > About Minitab.
2. Click Borrow License.
3. In Borrow Through, choose a return date on the calendar.
4. Click Borrow and then click OK.
A borrowed license is returned automatically at the end of the borrowing period. To return a license before the end
of the borrowing period, choose Help > About Minitab and click Return License.
Note

To limit the number of licenses that can be borrowed, use the Options file. For an example, see Options file on page 16.

Standalone configuration
In a standalone configuration, Minitab products do not depend on accessing a network server. Instead, the Minitab
License Manager server software is installed on the same workstation as the client software, Minitab 18. The Minitab
License Manager starts two daemons that are required to run on each standalone workstation. When Minitab 18 starts,
it checks the Minitab License Manager service that is on the same workstation, regardless of network connectivity. An
individual license file must be created for each workstation.

Mixed configurations
You can use a combination of networked and standalone configurations. For example, you can install Minitab 18 on
20 workstations that are connected to the network and also install Minitab 18 on 5 standalone workstations that are
not connected to the network.
For information on mixed installation configurations and license files, see Number of license files on page 10.

Minitab License Manager
All multi-user installation configurations require the installation of the Minitab License Manager, the server software
that manages the use of Minitab 18. The Minitab License Manager ensures that the number of concurrent users does
not exceed the licensed number of seats, based on the information in the license file.
The Minitab License Manager starts its service automatically when you install it. However, you may need to restart the
Minitab License Manager service in some cases, such as when you make changes to the license file or use an options
file.

To restart Minitab License Manager
1. Open Windows services on the computer:

•

In Windows 7 or later, click the Windows logo (Start). Type services.msc in the search box and press Enter.

2. Click Minitab License Manager.
3. Choose Action > Restart.
Note If you need to uninstall Minitab License Manager from a computer, such as when you change servers or installation configurations,
you must first stop the license manager service. Follow steps 1 and 2 above; in step 3, choose Action > Stop. Then uninstall the Minitab
License Manager.
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License Files
License files are required for the installation of Minitab multi-user products. This section provides general background
information on license files, including what they are, where they're created and stored, and how they're used. For
instructions on how to work with license files after installation, see License Manager Utility on page 14.

Using license files
What is a license file?
A license file is a text file named minitab.lic. The file does not have a .txt extension, but you can open it in a standard
text editor such as Notepad. The file contains information about the licenses that your organization purchased. This
information includes the expiration date, the number of licenses, and the computer's MAC address.
After you create a license file at the Minitab multi-user licensing web pages, save it to the desktop of the computer
on which you will install the Minitab License Manager, the server software that manages the use of Minitab 18 based
on the information in the license file.

Sample license file
SERVER this_host 0A1B2C3D4E5F
VENDOR minitab
USE_SERVER
INCREMENT Minitab Minitab 18 31-dec-2016 100 VENDOR_STRING="limited \
term, limited users, borrowing enabled" DUP_GROUP=UH \
ISSUER=Minitab ISSUED=01-jan-2016 BORROW=26280 \
NOTICE="Customer ID: 01234 License Coord ID: 56789 \
RENI01234" SN="STDORD56789 01234INC" START=01-oct-2015 \
SIGN="1c71 F7B8 641F 7A84 F052 9650 F5E6 B093 ACBC 04C4 AF4D \
5B3B 0F38 C3FB DF49 1720 F1BA D1CD 646D 4C9D 824B E7A9 F724 \
3EDA 9B09 5628 733F F646 AC87 6C39"
In the sample license file above, the terms in bold specify the following information:
0A1B2C3D4E5F
the unique MAC address of the computer for which this license file was created.
Minitab 18
the name of the product for which the license file was created.
31-dec-2016
the expiration date of the license file.
100
the number of users allowed to concurrently run the software.
Each license file is created for a single computer. The computer is identified in the license file by its MAC address. The
license file cannot be used on a computer that does not have the MAC address specified in the license file.
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How license files are used
During the installation of Minitab License Manager, you need to provide the location of the license file. By default, the
installation looks to the desktop for the license file and then creates a copy of the license file in C:\Program Files
(x86)\Minitab\License Manager. The Minitab License Manager service is then installed. The service reads the license
files and then starts.
Note

After you install Minitab License Manager, you can delete the license file that is on the desktop.

Authorized users can create license files at the Minitab Multi-User Licensing web pages. See Create License File(s) on
page 5 for more information.

Number of license files
You need one license file for each Minitab License Manager that you install. In a typical networked configuration,
Minitab License Manager is installed on a single server. In this case, only one license file is needed. For example, Minitab
License Manager is installed on a single server that will serve all 100 licenses. You need to create a single license file
for all 100 seats.
You can also divide your licenses among multiple servers, if desired. For example, Minitab License Manager is installed
on two servers, one for 75 users in Department A and the other for 25 users in Department B. This installation
configuration requires two license files: one file for 75 seats and another file for 25 seats.
In a standalone configuration, Minitab License Manager must be installed on each workstation. As a result, a unique
license file is required for each installation of Minitab License Manager. For example, a small computer training lab
has 10 computers that are not networked. You need to install Minitab 18 and Minitab License Manager on all 10
computers. This installation configuration requires 10 license files, one for each computer.
You can have a combination of networked and standalone installations. You need to create a single license file for the
server and a separate license file for each standalone workstation. For example, an organization purchases 100 licenses
for Minitab 18. They want 10 standalone installations in the computer lab. A single server will host the remaining 90
licenses. This installation configuration requires 11 license files: one for the server and one for each of the 10 standalone
workstations.

Adding a second product or additional users to your
license file
When you purchase both Minitab and Companion, you must initially create two separate license files at the multi-user
licensing web pages, one for each product. However, to install both products, you need to merge the two license files
into one file. After you download both license files, append the contents of one license file to the other license file.
You can also add additional users to your license, which also involves appending the contents of your new license file
to the existing file.

To append an additional product to a license file
You may need to be logged in as an administrator to perform the following steps.
1. At http://it.minitab.com/support/licensing/multi-user/customer-entitlement-summary.aspx , create a separate
license file for the additional product.
2. Save the new license file to the desktop. Do not overwrite the existing license file in C:\Program Files
(x86)\Minitab\License Manager.
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3. Open the new license file for the additional product in Notepad.
4. Copy everything from the INCREMENT line down.
5. Close the license file that is on the desktop.
6. Open the original license file in C:\Program Files (x86)\Minitab\License Manager in Notepad.
7. Paste the copied contents of the new license file to the end of the original license file.
8. Choose File > Save.
9. Restart the Minitab License Manager service. See To restart Minitab License Manager on page 8 for more
information.
10. To verify your change, double-click lmtools.exe in the installation directory (by default, C:\Program Files
(x86)\Minitab\License Manager).
11. Click the Server Status tab.
12. Click Perform Status Enquiry.
13. In the results window, look for the line that includes Users of product where product = the Minitab product
you added to your license.

Example of a license file with appended product
SERVER this_host 0A1B2C3D4E5F
VENDOR minitab
USE_SERVER
INCREMENT Minitab minitab 18 31-dec-2016 50 VENDOR_STRING="limited \
term, limited users, borrowing enabled" DUP_GROUP=UH \
ISSUER=Minitab ISSUED=01-jan-2011 BORROW=26280 \
NOTICE="Customer ID: 01234 License Coord ID: 56789 \
RENI01234" SN="STDORD56789 01234INC" START=01-oct-2015 \
SIGN="1C71 F7B8 641F 7A84 F052 9650 F5E6 B093 ACBC 04C4 AF4D \
5B3B 0F38 C3FB DF49 1720 F1BA D1CD 646D 4C9D 824B E7A9 F724 \
3EDA 9B09 5628 733F F646 AC87 6C39"
INCREMENT companion minitab 5 31-jan-2017 8 VENDOR_STRING="limited \
term, limited users, borrowing enabled" DUP_GROUP=UH \
ISSUER=Minitab ISSUED=01-mar-2016 BORROW=26280 \
NOTICE="Customer ID: 01234 License Coord ID: 56789 \
RENI01234" SN="STDORD31415 01234INC" START=01-nov-2015 \
SIGN="1EA6 00D1 E785 EEA9 F026 63B5 BBA0 B8B0 CAB9 \
91CA A57A D123 D9DD 0372 A1CD 136F 12F4 ABCB EA0A 3AD9 A71F \
F014 7B78 A683 6EB2 FCC6 9685 0D66 6355 441C"

To append additional users to a license file
You may need to be logged in as an administrator to perform the following steps.
1. At http://it.minitab.com/support/licensing/multi-user/customer-entitlement-summary.aspx , create a separate
license file for the additional users.
2. Save the new license file to the desktop. Do not overwrite the existing license file in C:\Program Files
(x86)\Minitab\License Manager.
3. Open the new license file for the additional users in Notepad.
4. Copy everything from the INCREMENT line down.
5. Close the license file that is on the desktop.
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6. Open the original license file in C:\Program Files (x86)\Minitab\License Manager in Notepad.
7. Paste the copied contents of the new license file to the end of the original license file.
8. Choose File > Save.
9. Restart the Minitab License Manager service. See To restart Minitab License Manager on page 8 for more
information.
10. To verify your change, double-click lmtools.exe in the installation directory (by default, C:\Program Files
(x86)\Minitab\License Manager).
11. Click the Server Status tab.
12. Click Perform Status Enquiry.
13. In the results window, look for the line that includes Total of x licenses issued and confirm that x is equal
to the total number of licenses (original + added).

Example of a license file with appended users
SERVER this_host 0A1B2C3D4E5F
VENDOR minitab
USE_SERVER
INCREMENT Minitab Minitab 18 31-dec-2015 100 VENDOR_STRING="limited \
term, limited users, borrowing enabled" DUP_GROUP=UH \
ISSUER=Minitab ISSUED=01-jan-2015 BORROW=26280 \
NOTICE="Customer ID: 01234 License Coord ID: 56789 \
RENI01234" SN="STDORD56789 01234INC" START=01-oct-2014 \
SIGN="1c71 F7B8 641F 7A84 F052 9650 F5E6 B093 ACBC 04C4 AF4D \
5B3B 0F38 C3FB DF49 1720 F1BA D1CD 646D 4C9D 824B E7A9 F724 \
3EDA 9B09 5628 733F F646 AC87 6C39"
INCREMENT Minitab Minitab 18 31-jan-2016 25 VENDOR_STRING="limited \
term, limited users, borrowing enabled" DUP_GROUP_UH \
ISSUER=Minitab ISSUED=01-mar-2015 BORROW=26280 \
NOTICE="Customer ID: 01234 License Coord ID: 56789 \
RENI01234" SN="STDORD31415 01234INC" START=01-nov-2014 \
SIGN="1c71 F7B8 641F 7A84 F052 9650 F5E6 B093 ACBC 04C4 AF4D \
5B3B 0F38 C3FB DF49 1720 F1BA D1CD 646D 4C9D 824B E7A9 F724 \
3EDA 9B09 5628 733F F646 AC87 6C39"

Renewing licenses
To avoid "checkout failed" error messages that are caused by expired license files, renew your organization's Minitab
18 license before it expires.
1. Your organization's License Coordinator must purchase a new license for your organization.
2. An authorized user must log in and generate new license files at
http://it.minitab.com/support/licensing/multi-user/customer-entitlement-summary.aspx .
See Step 3: Create license file(s) on page 5 for more information about creating license files.
3. Replace the existing license file with the new license file in C:\Program Files (x86)\Minitab\License Manager.
4. Restart Minitab License Manager. See To restart Minitab License Manager on page 8 for more information.
Note

License files are created with an expiration date. Minitab 18 will not start if the license is expired.
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Installation options
•
•
•

Choose the default language for Minitab 18.
Choose a license type (single-user, multi-user, or trial)
Optionally change the destination folder. By default, Minitab 18 is installed to C:\Program Files (x86)\Minitab\Minitab
18.

Checking for updates
Checking for updates is enabled by default. An automatic check occurs upon every launch of the product, and each
user is able to manually check for updates at any time. You can set an optional property during deployment to disable
checking for updates. See To customize your deployment on page 17 for additional details.

To manually check for updates
1. Open Minitab 18.
2. Choose Help > Check for Updates.
3. If an update is available, follow the instructions to update your software.

To disable checking for updates
1. Open Programs and Features.
a. Click the Start button.
b. Click Control Panel.
c. Click Programs.
d. Click Programs and Features.
2. Select Minitab 18 and then click Uninstall/Change.
You might be prompted for an administrator password or confirmation.
3. In the Minitab 18 Setup dialog box, select Change.
4. Uncheck Enable checking for software updates.
5. Click Next, and then click Install.
Note If you choose to remove or not enable checking for updates, you will not be automatically informed of critical updates, bug fixes, or
notifications of problems or errors.
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Changing license types
A valid license is required to use Minitab 18. There may be times when it is necessary to switch from one license type
to another. For example, you change your license type when you switch from a trial license to a multi-user license
utilizing a license server.
1. Open Programs and Features.
a. Click the Start button.
b. Click Control Panel.
c. Click Programs.
d. Click Programs and Features.
2. Select Minitab 18 and then click Uninstall/Change.
You might be prompted for an administrator password or confirmation.
3. In the Minitab 18 Setup dialog box, select Change.
4. Select Change License Type.
5. Click Next and enter the required licensing information.
Note

If the license type that you want is not available, you need to reinstall Minitab 18.

License manager utility
Flexera Software provides the lmtools.exe utility for performing license management tasks. This utility provides a
graphical user interface to access all the license management tasks. To use LMTOOLS, navigate to the license manager
installation folder (C:\Program Files (x86)\Minitab\License Manager by default) and double-click lmtools.exe.
For more information on LMTOOLS, refer to the FlexNet Publisher License Administration Guide distributed by Flexera
Software LLC.
You can use this utility to check the status of Minitab License Manager and to help you monitor network licensing
activities, such as the number of licenses in use and who is using them. You can also review configuration settings.
See Check Minitab License Manager status and settings on page 22 for more information.

Specifying ports
Minitab 18 uses two ports for communication between the workstation and the server: the license manager (lmgrd.exe)
port and the vendor daemon (minitab.exe) port. You can modify the license file to specify which port numbers Minitab
18 should use.
Specifying ports manually is useful when you need to identify them as open ports on firewalls. When communication
appears to be blocked, configure these open ports on any firewall on or between the workstation and server, including
software firewalls such as Windows firewall. See FLEXnet error 96 on page 24 for more information.
You can specify both the license manager and vendor daemon ports in the same license file. Make a backup of your
license file before you edit it.
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To specify a license manager port
The license manager (lmgrd.exe) automatically chooses the first available port between 27000 and 27009 each time
the Minitab License Manager service starts. You can set this port number to a permanent value.
You may need to be logged in as an administrator to perform the following steps.
1. Open the license file in C:\Program Files (x86)\Minitab\License Manager in Notepad.
2. Type the port number after the MAC address on the first line. Leave a space between the MAC address and port
number, as shown in the example below step 7.
3. Save the file.
4. Restart the Minitab License Manager service to re-read the license file. See To restart Minitab License Manager on
page 8.
5. To verify your change, open the Minitab License Manager log file, minitab.dl, which is located at
C:\Programdata\Minitab\License Manager, in Notepad.
6. Locate the line that includes lmgrd tcp-port.
7. Make sure that the port number on this line is correct. For example, lmgrd tcp-port 27001 .
Example of license file with specified license manager port of 27001:
SERVER this_host 0A1B2C3D4E5F 27001
VENDOR minitab
USE_SERVER
INCREMENT Minitab minitab 18 31-dec-2016 100 VENDOR_STRING=”limited \
term, limited users, borrowing enabled” DUP_GROUP=UH \
ISSUER=Minitab ISSUED=01-jan-2014 BORROW=26280 \
NOTICE=”Customer ID: 01234 License Coord ID: 56789 \
RENI01234” SN=”STDORD56789 01234INC” START=01-oct-2013 \
SIGN=”1C71 F7B8 641F 7A84 F052 9650 F5E6 B093 ACBC 04C4 AF4D \
5B3B 0F38 C3FB DF49 1720 F1BA D1CD 646D 4C9D 824B E7A9 F724 \
3EDA 9B09 5628 733F F646 AC87 6C39”

To specify a vendor daemon port
The vendor daemon (minitab.exe) port is dynamically assigned from a wide range of port numbers each time the
Minitab License Manager service starts. You can set this port number to a permanent value.
You may need to be logged in as an administrator to perform the following steps.
1. Open the license file in C:\Program Files (x86)\Minitab\License Manager in Notepad.
2. Type port= and the port number at the end of the second line ("port" is case-sensitive). Leave a space between
minitab and port=.
3. Save the file.
4. Restart the Minitab License Manager service to re-read the license file. See To restart Minitab License Manager on
page 8.
5. To verify your change, open the Minitab License Manager log file, minitab.dl, which is located at
C:\Programdata\Minitab\License Manager, in Notepad.
6. Locate the line that includes minitab using TCP-port.
7. Make sure that the port number on this line is correct. For example, minitab using TCP=port 3000 .
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Example of license file with specified vender daemon port of 3000:
SERVER this_host 0A1B2C3D4E5F
VENDOR minitab port=3000
USE_SERVER
INCREMENT Minitab minitab 18 31-dec-2016 100 VENDOR_STRING=”limited \
term, limited users, borrowing enabled” DUP_GROUP=UH \
ISSUER=Minitab ISSUED=01-jan-2011 BORROW=26280 \
NOTICE=”Customer ID: 01234 License Coord ID: 56789 \
RENI01234” SN=”STDORD56789 01234INC” START=01-oct-2010 \
SIGN=”1C71 F7B8 641F 7A84 F052 9650 F5E6 B093 ACBC 04C4 AF4D \

Options file
You can use the options file to control various license system options for the Minitab License Manager, such as reserving
or excluding licenses for a person or group.

To use an options file
You may need to be logged in as an administrator to perform the following steps.
1. Open a new file in Notepad.
2. Type your settings with the appropriate syntax, as documented in the FlexNet Publisher License Administration
Guide distributed by Flexera Software LLC. See the bottom of this topic for an example options file.
3. Choose File > Save As and browse to the same folder as minitab.lic (C:\Program Files (x86)\Minitab\License
Manager).
4. In File name, type minitab.opt.
5. In Save as Type, choose All Files.
6. Click Save.
7. Restart the Minitab License Manager service. See To restart Minitab License Manager on page 8.
8. To verify that the options file is successfully implemented, open the Minitab License Manager log file, minitab.dl,
at C:\Programdata\Minitab\License Manager, in Notepad.
9. Locate the line that includes Using options file:<path_to_options_file>. If this text is present, the
options file has been successfully implemented.
If a minitab.opt is present, the Minitab License Manager service reads it and implements the settings in the file.
In the example below of an options file, line 1 prevents the user tjones from using Minitab. Line 2 prevents the same
user from using Companion. Line 3 creates a group named "quality" and defines members of that group. Line 4 reserves
three licenses for the quality group. Line 5 specifies that 5 licenses cannot be borrowed.
EXCLUDE Minitab USER tjones
EXCLUDE companion USER tjones
GROUP quality jsmith bmiller awilson
RESERVE 3 minitab GROUP quality
BORROW_LOWWATER minitab 5
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Command line installation
You can use the command line to install Minitab 18 on the client computer. To do so, you must specify the license
information for each installation using the appropriate command line syntax.

To customize your deployment
The tables below outline properties and switches that can be used for command line or mass deployment to your
end-users.

EXE Switch Table
Command Line Switch

Accepted Values

Description

/exelang

1031
1033
1036
1041
1042
1046
2052
1034

Specify the default language of the
installation and application. If language
is not specified, the installer will use
your system regional settings for the
default language, or default to English
if a match is not found.
1031=German
1033=English
1036=French
1041=Japanese
1042=Korean
1046=Portuguese
2052=Simplified Chinese
1034=Spanish

/exenoui

Required for a silent install. Use with
appropriate MSI switch for modified
end-user experience (e.g., /qn, /qb,
/passive).

MSI Switch Table (Common)
Command Line Switch

Description

/passive

Basic user interface, progress bar only

/qn

Quiet, no user interface

/qb

Basic user interface, the Cancel button will be active during
installation

/qr

Reduced user interface, the Cancel button will be active
during installation

Property Table
Property
APPDIR

Accepted Values

Description
Specify a custom installation directory
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Property

Accepted Values

Description

ACCEPT_EULA

1

Required property. By specifying a
value for this property, you accept the
terms of the end-user license
agreement.

LICENSE_SERVER

server name or IP address

For use with a multi-user license to
specify the server that hosts the
Minitab License Manager. This
property is not compatible with
PRODUCT_KEY.

LICENSE_SERVER_PORT

27000 to 27009

For use with a multi-user license to
optionally specify the listening port for
the Minitab License Manager server.

PRODUCT_KEY

18-digit Product Key

Single-user licenses can be optionally
activated by specifying a Product Key.
Without specifying a product key, a
30-day trial will be installed. This
property is not compatible with
LICENSE_SERVER.

DISABLE_ANALYTICS

1

Minitab collects anonymous
application usage data to improve the
software and enhance the user
experience. By specifying a value for
this property, you can opt out of
application usage data collection.
However, please note that this does
not prevent Minitab from collecting
other types of data from its websites
and products, such as data necessary
for managing licenses or accessing
online Help.
For more information, view our Privacy
Policy.
Examples of anonymous application
usage data:

•

Product information, including the
types of files that are imported, the
types and frequency of tools and
commands that are used, the size
and nature of projects, and the
frequency and duration of use

•

Performance information about
Minitab products and/or services
and any issues you may experience
while using them

Note: We do not collect any
user-entered data or statistical results.
DISABLE_MOVE

1

For use with a single-user license to
turn off the ability for an end-user to
move an activated license.
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Property

Accepted Values

Description

LCID

1031
1033
1036
1041
1042
1046
2052
1034

Specify the default language of the
installation and application. This
property can only be set within
Minitab18.x.x.xsetupgp.msi. Refer to
EXE Switch Table for additional
language options.
1031=German
1033=English
1036=French
1041=Japanese
1042=Korean
1046=Portuguese
2052=Simplified Chinese
1034=Spanish

DISABLE_UPDATES

1

When you specify a value for this
property, you turn off the ability to
check for software updates. Disabling
this option prevents automatic and
manual checks from occurring. We
recommend that you enable this
option on at least one computer.

Command Line Details
1. You must use the /exenoui switch when you use /qn, /qb, or /passive.
2. Verify that command line switches are in correct order.

•
•

EXE switches must precede MSI switches.
MSI switches must precede MSI properties.

3. If you do not specify licensing properties (PRODUCT_KEY or LICENSE_SERVER), a 30-day trial will be installed.
4. If you install with a local license file, place it in the same directory as the installer and do not specify a license type
property (PRODUCT_KEY or LICENSE_SERVER).
5. If you have a previous version of Minitab 18 installed, the existing values will be used for APPDIR, LICENSE_SERVER,
LICENSE_SERVER_PORT, PRODUCT_KEY, and DISABLE_MOVE if they are not specified during the upgrade.

Examples
Required syntax: minitab18.x.x.xsetup.exe [EXE Switch Table] [MSI Switch Table] [Property Table]
Install silently, English default language, and multi-user license:
minitab18.x.x.xsetup.exe /exenoui /exelang 1033 /qn ACCEPT_EULA=1
LICENSE_SERVER=MyServerName
Install silently, Simplified Chinese default language, multi-user license setting server and port, and checking
for updates disabled:
minitab18.x.x.xsetup.exe /exenoui /exelang 2052 /qn ACCEPT_EULA=1
LICENSE_SERVER=MyServerName LICENSE_SERVER_PORT=27000 DISABLE_UPDATES=1
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Install silently, Portuguese default language, single-user license with product key, and custom installation
directory:
minitab18.x.x.xsetup.exe /exenoui /exelang 1046 /qn ACCEPT_EULA=1
PRODUCT_KEY=123456789012345678 APPDIR= "c:\New Minitab 18"
Install silently, German default language, and single-user license 30-day trial:
minitab18.x.x.xsetup.exe /exenoui /exelang 1031 /qn ACCEPT_EULA=1
Upgrade Minitab 18 silently:
minitab18.x.x.xsetup.exe /exenoui /qn ACCEPT_EULA=1
Uninstall silently using the Minitab 18 product code:
msiexec /x {Product Code} /qn
Product Code Registry Location:
[HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\Microsoft\Windows\CurrentVersion\Uninstall\Minitab 18]
String: UninstallPath

To deploy a Minitab installation
If you use a software asset management tool for deployment, use the exe to deploy Minitab 18.
If you use Active Directory/Group Policy for deployment, minitab18.x.x.xsetupgp.msi is also required. This file is provided
with the Minitab 18 Mass Deployment Package at http://www.minitab.com/downloads/.

Group policy usage
1. When you use minitab18.x.x.xsetupgp.msi, the installation package must be in the same directory.
2. If you install with a local license file, place it in the same directory as the installation package and do not specify a
license type property (PRODUCT_KEY or LICENSE_SERVER).
3. Set the MSI REBOOT property to control reboot behavior on end-users' machines.

Identical settings on multiple computers
To ensure that multiple computers have identical Minitab 18 settings, you can use Tools > Manage Profiles to create
and export a preinstall profile as a registry file named OrgDefs.reg and include it with the installation files.
This process requires that you open Minitab with its original (unmodified) profile settings. Therefore, it is recommended
that you log in to your computer as a user that has not previously modified Minitab profile settings.

To implement a preinstall profile
1. Open Minitab on a computer that does not have any modified profile settings. If you are unsure whether the profile
settings have been modified, open Minitab using an Administrator account that has not previously been used to
open Minitab.
2. Adjust any settings that you want to share on multiple computers.
3. Choose Tools > Manage Profiles.
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4. Move MyProfile from Active profiles to Available profiles by clicking the arrow. (To be exported, profiles must
be under Available profiles.)
5. With the profile selected, click Export.
6. In Save In, browse to the save location.
7. In File name, rename MyProfile to OrgDefs.reg. Click Save.
8. You need to deploy OrgDefs.reg to the user's C:\Program Files (x86)\Minitab\Minitab18\Language\Profiles folder.
Note You must copy or deploy a custom profile to each user’s Minitab 18\Language\Profiles folder after installing but before opening
Minitab for the first time. The Program Files (x86) folder is protected. If you have installed Minitab to this protected area (which is the default),
the profile must be copied to the Minitab 18\Language\Profiles folder by a user with administrative-level access for all system users to have
access to it.

When a user opens Minitab for the first time, the file is imported. The imported profile is named $$OrganizationDefaults.
For more information on profiles, type Profiles in the Minitab Help index.
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Troubleshooting
This section provides information for troubleshooting problems related to licensing and installing Minitab products.

Log files
You can generate log files to use for troubleshooting with both Minitab 18 and Minitab License Manager.

Installation log file
An installation log file can be created by utilizing the following command: Minitab18.x.x.xsetup.exe /exenoui /qn /l*v
c:\Install.log ACCEPT_EULA=1 LICENSE_SERVER=MyServerName
The installation log file contains information such as the time and date of installation and the folder to which the
software was installed.

Minitab License Manager log file
Minitab License Manager is the server software that controls the use of your license. It generates a log file that is
updated with events, such as license check-ins, check-outs, and error messages. By default, the log file is named
Minitab.dl and is located at C:\Programdata\Minitab\LicenseManager.
To read the Minitab License Manager log file, open it in Notepad.
Note For detailed information on the Minitab License Manager log file, refer to the FlexNet Publisher License Administration Guide
distributed by Flexera Software LLC.

Check Minitab License Manager status and settings
You can check the status of Minitab License Manager to help you monitor network licensing activities, such as the
number of licenses in use and who is using them. You can also review configuration settings.
1.

Navigate to Minitab License Manager folder (by default, at C:\Program Files (x86)\Minitab\License Manager).

2.

Double-click lmtools.exe.

3.

Do any of the following:

•
•
•

To check server status, click the Server Status tab. Click Perform Status Enquiry.
To check server configuration, click the Config Services tab.
To check license information, click the Server Diags tab. Click Perform Diagnostics.
The number of licenses are listed, as shown in this example:
Users of Minitab: (Total of 50 licenses used; Total of 33 licenses in use)
Specific details about each license are also listed:
jsmith LAB_PCLAB_PC (v1.0)(LAB_PC/27000 302), start Fri 3/1 4:15
jsmith is the user name, LAB_PC is the computer name, and 27000 is the license manager port
Borrowed licences display the expiration in seconds. For example, the license below will expire in 314159
seconds:
jsmith LAB_PCLAB_PC (v1.0)(LAB_PC/27000 302), start Fri 3/1 4:15 (linger: 314159)
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FLEXnet license errors
You may encounter several types of FLEXnet error messages that indicate that you cannot check out a license. These
messages are formatted in general as follows:
FLEXNET License Error Number: Error text.
For example:
FLEXNET License Error -97-121-0: Check out failed
Some of the errors that you may encounter are listed below. For a complete list of possible error codes, see the FlexNet
Publisher License Administration Guide.

FLEXnet error 15
Possible cause

Explanation

The server name that was provided during the installation The server name that was provided during the installation
of Minitab 18 on the client computer is not valid.
of Minitab 18 on the client computer is used to locate that
server on the network. Make sure that the server name is
valid. For instructions on locating the server name, see
http://support.minitab.com/installation/frequently-askedquestions/minitab-license-manager/change-defaultlocation-where-minitab-companion-look-for-licensemanager/.

FLEXnet error 25
Possible cause

Explanation

You are using Minitab 18 with an invalid license file.

The license file that is managed by Minitab License
Manager supports some other Minitab product. To resolve
this, you need to create a new license file for Minitab 18.

FLEXnet error 34
Possible cause

Explanation

The date differs in excess of 24 hours between the client
computer and the Minitab License Manager server.

If the date difference is greater than 24 hours, Minitab
License Manager will refuse to grant the license. Reset the
clock on the client computer.

FLEXnet error 92
Possible cause

Explanation

The MAC address in the license file does not match the
MAC address of the Minitab License Manager server.

The MAC address in the license file must match the MAC
address of an enabled network adapter on Minitab License
Manager. See License Files on page 9 for more
information.
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FLEXnet error 68
Possible cause

Explanation

The license file is not configured to allow for borrowing.

Not all licenses are borrow-enabled. Borrow-enabled
licenses will have "borrow-enabled" within the text of the
license file.

FLEXnet error 95
Possible cause

Explanation

You are browsing to a license file in a standalone
configuration.

Your license type may not support this method. In the Find
License dialog box, instead of choosing Specify the
License File, choose Specify the License Server System.
Type the server name. For example, type @localhost.

FLEXnet error 96
Possible cause

Explanation

Firewalls or network configurations are blocking
communications between the client computer and the
Minitab License Manager server.

The client computer must be able to communicate with
the Minitab License Manager server over two ports: the
Minitab License Manager (lmgrd.exe) port and the minitab
vendor daemon (minitab.exe) port. You can use telnet to
test communications. See the Minitab License Manager
log file on page 22 to determine which port numbers are
used. See Specifying ports on page 14 to manually
configure ports.

The Minitab License Manager service is not running on the The Minitab License Manager service must be running to
license server.
process license requests for Minitab 18.

FLEXnet error 97
Possible cause

Explanation

The MAC address in the license file does not match the
MAC address of the Minitab License Manager server.

The MAC address in the license file must match the MAC
address of an enabled network adapter on Minitab License
Manager. See License Files on page 9 for more
information.

The license expired.

The expiration date for your license is specified in the
license file. Minitab 18 is not usable after the expiration
date. See License Files on page 9 for more information.

The network adaptor on the Minitab License Manager
server is disabled.

The network adaptor card must be enabled for the Minitab
License Manager server to verify the MAC address. Without
this, Minitab 18 cannot start. This issue is most commonly
encountered with laptop computers that may change the
status of a network card under various conditions.

The license file was modified.

You can make a few valid changes to the license file, such
as specifying a port number. Most other changes will
corrupt the license file, making it unusable to Minitab
License Manager.
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Possible cause

Explanation

The date is incorrect on the computer that runs Minitab
License Manager software.

Minitab installations are sensitive to the computer's date.

Minitab License Manager is installed to C:\FlexLM\Minitab. Minitab License Manager should not be installed to this
directory. Uninstall Minitab License Manager and install to
another directory.
The Minitab License Manager service is not running on the The Minitab License Manager service must be running to
license server.
provide license requests for Minitab 18.
Minitab License Manager is using a different
communication port than expected.

Multiple FLEXlm license managers may be running on this
server, which caused the Minitab License Manager to use
a different port. See To specify a license manager port on
page 15 to manually configure ports.

FLEXnet error 104
Possible cause

Explanation

You attempt to borrow a license longer than is allowed by You cannot borrow a license beyond the expiration data
either the expiration date in the license file or a limit set of the license file. If the specified end date for borrowing
in the options file.
is before the expiration date, the options file may contain
limits on borrowing. See Options file on page 16 for more
information.

Minitab License Manager fails to start
If the Minitab License Manager service fails to start, you may see the following error message:
The Minitab License Manager service on Local Computer started and then stopped. Some services stop automatically
if they have no work to do, for example, the Performance Logs and Alerts Services.
Use the following table to troubleshoot the problem:
Possible cause

Explanation

The license file (minitab.lic) is not in the Minitab License
Manager installation directory.

Minitab License Manager browses to C:\Program Files
(x86)\Minitab\License Manager for the license file. Ensure
that minitab.lic is at this location.

The license file is not named correctly.

The license file must be named "minitab.lic" (unless this
default value was modified later). Make sure that the file
is not named minitab.lic.txt (a common mistake). Confirm
that the file does not end with .txt. Right-click the file,
choose Properties, and verify that Type of file is License
and not Text Document.

Extra text is in the license file.

Some text editors, such as WordPad, may add unwanted
content to your file. See Sample license file on page 9
for an example of a license file with no unnecessary text.
Open the file in Notepad.
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Explanation

Minitab License Manager does not have permission to
By default, Minitab License Manager creates minitab.dl in
write the log file (minitab.dl) to the directory specified in C:\Programdata\Minitab\License Manager. You can specify
the Config Services tab of LMTOOLS.
a different directory with LMTOOLS (lmtools.exe). Make
sure that the account that runs the Minitab License
Manager service has write access to this directory.
Minitab License Manager server has non-ANSI characters For best results, install Minitab License Manager to a
in its name.
computer with only ANSI characters in its name.

Web site errors
Access Denied
If you try to log in to the Minitab multi-user license management web pages and you are not an authorized user, the
Access Denied error message may appear. For more information, see Step 1: Designate authorized users of multi-user
licensing web pages on page 4.

Unable to Proceed: Entitlements Not Available
If you log in to the multi-user license management web pages to create license files and there are no valid orders for
your organization, the message Unable to Proceed: Entitlements Not Available appears. Contact your
Minitab Sales Representative.

Online resources
The following online resources are available:

•
•
•
•

Troubleshooting solutions at http://support.minitab.com/installation/
The latest downloads for Minitab multi-user products at http://www.minitab.com/downloads/
The latest documentation for Minitab multi-user products at http://www.minitab.com/support/documentation/
The FlexNet Publisher License Administration Guide at
www.minitab.com/uploadedFiles/Documents/license-management/FlexNetLicenseAdminGuide.pdf

26

Index
A
administrative installation 17
authorized users of web pages 4

B
borrowing a license 7

C
checking for updates 13
command line installation 17
configuration file 17
creating license files 5
custom profiles 20

D
debug file 26
deployment 17
documentation
online 26
downloads
online 26

troubleshooting 25
license files 9
license type
change 14
LMTOOLS 14, 22
log files 22
Minitab License Manager log file 22

M
MAC address 5
Minitab License Coordinator 4
Minitab License Manager 8
administrative tools and procedures
14
checking status 22
troubleshooting 22
utility 14
minitab.dl 26
minitab.lic 9
multi-user licensing 4
multi-user licensing web pages 4, 5

T
troubleshooting
debug file 26
expired license 24
FLEXnet license errors 23
installation 22
license file 25
Minitab License Manager 22, 25
minitab.dl 26
network adaptor 24

U
updates 13

N
network adaptor 24
networked configuration 7

E
expired license 24

F
firewalls 24
FLEXnet license errors 23

G
group policy usage 20

I
installation
configuration 4
configuration file 17
quick start 4
troubleshooting 22

L
license coordinator 4
license file
creating 5

O
online resources 26
options file 16
OrgDefs.reg 20

P
ports 14
license manager 15
vendor daemon 15
profiles 20

R
renewing licenses 12

S
settings repeated on multiple
computers 20
single-user licensing 4
software updates 13
standalone configuration 8
system requirements 6

27

